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Introduction 

About This Document 

This document explains the setup process for a system composed primarily of products for the Yamaha New 
Commercial Installation Solutions Ecosystem (hereinafter referred to as the New CIS Ecosystem). 

For more information on each product, refer to the respective product manuals. For details on the ProVisionaire 
series, refer to the respective ProVisionaire series manuals. 

Note 

• Yamaha Corporation owns all copyrights to this software series and this Setup Guide.

• This software series and this Setup Guide may not be reproduced or modified, in whole or in part, without
permission.

• Please note that Yamaha will not be held responsible for any results or consequences of using this software
series or this Setup Guide.

• For information on modifications to the system software and certain functions or specifications that may
occur due to application upgrades or other reasons, refer to the Yamaha Pro Audio website.
https://www.yamahaproaudio.com/

• All illustrations and screenshots in this Setup Guide are for illustrative purposes only. Therefore, they may
differ from the actual specifications. For the latest information, refer to the Yamaha Pro Audio website.
https://www.yamahaproaudio.com/

• Music and sound data sold or provided by Yamaha Corporation or third parties may not be reproduced or
reused without the permission from the rights holder, except in cases where copyright law does not apply,
such as reproduction for personal use. When planning to use these data or materials, please obtain permission
from the rights holder or consult a copyright expert as necessary.

• Windows is a registered trademark of Microsoft Corporation (US) in the United States and/or other countries.

• iPad is a trademark of Apple Inc., registered in the United States and/or other countries.

• Other company names and products that appear in this document are trademarks or registered trademarks of
the respective companies.

https://www.yamahaproaudio.com/
https://www.yamahaproaudio.com/
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System Description 
This document explains how to set up the system using a DME unit and ProVisionaire Design software. This 
document describes the general setup procedure for configuring the following system, which is assumed to be a 
representative example. When configuring an actual system, specify the settings appropriate for the equipment 
being used on-site. 

System Overview 
A hotel lobby divided into two zones 

• BGM is played in each zone.
• You can use a wall-mount controller in each zone to turn respective speakers on or off and adjust the volume

levels.
• For overall operation (such as selecting a sound source and adjusting the volume level for each speaker system),

you can use a control terminal in the back room.
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Block Diagram 

Device Configuration 
This document presumes the following devices. 

Device name Product number Quantity 

Signal processor DME3 1 

Power amplifier XMS12s4-D 1 

Surface-mount speaker VXS5 As needed 

Ceiling speaker VXC6 As needed 

Wall-mount controller MCP2 2 

Touchscreen Control Device TCD10 1 

L2 switch SWR2311P-10G 2 

CD player CD-S303RK 2 

PC for playing music Third Party 1 

PC for setup Third Party 1 

*Select the type and number of speakers in accordance with the usage scenario.
In addition, select a power amplifier in accordance with the speaker requirements.

* This example does not include power control devices or UPS devices. If necessary, add them as appropriate to your
system.
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Software Used in this Example 
During the setup, the following software will be used. Icons of the software used in each step are indicated to the 
right of the headings. 

・ProVisionaire Design

ProVisionaire Design is Windows application software that can be used to design an integral acoustic system 
composed of Yamaha products. You can configure audio processing to suit your application by configuring audio 
signal routing and adjusting parameters for each component. 

The XMS series power amplifier included in this system example will be supported by ProVisionaire 
Design V3.1. 

Information about ProVisionaire Design for the XMS series will be updated regularly. 

・ProVisionaire Control PLUS

ProVisionaire Control PLUS is Windows application software that can be used to configure a remote controller for 
Windows PCs and iPads. 

・Dante Controller

Dante Controller is application software from Audinate that enables you to configure a Dante network and audio 
signal routing. 

For more information on the specifications and operation of the products and software described in this 
document, refer to the respective manuals. 

• Yamaha Pro Audio site
• ProVisionaire Design User Guide
• ProVisionaire Control PLUS User Guide

https://www.yamahaproaudio.com/
https://manual.yamaha.com/pa/pv/pvd/
https://manual.yamaha.com/pa/pv/pvcp/
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Workflow 
This document briefly describes the setup process to configure a system explained in the “System Description” 
chapter. During the actual setup, select the settings appropriate for your system. 

Preparation Work 

Installing software

Configuring devices with ProVisionaire Design

Launching ProVisionaire Design

Placing devices on the Project sheet

Configuring the processor

Placing and connecting components

Setting up the components

Analyzing the configuration for any problems (Compile)

Storing the settings to be assigned to the controller (Snapshot)

Grouping multiple faders or buttons for simultaneous control (Parameter Link Group)

Configuring the function so that the DME will control peripheral devices (Conductor)

Assigning functions to the controller

Configuring the power amplifier

Creating a control panel with ProVisionaire Control PLUS

Launch ProVisionaire Control PLUS

Placing the controllers on the control panel

Designing the control panel

On-site Work

Connecting the devices

Powering on the devices

Building the network

Finding devices with ProVisionaire Design

Specifying Unit IDs

Pushing ProVisionaire Design settings to devices

Configuring Dante Settings using Dante Controller

Verifying that the system is functioning properly

Storing initial data (Snapshot)

Exporting the controller file to the DME (Custom Control Panel)

Verifying that peripheral devices can be controlled from the control terminal

The following explanation of the workflow is based on the specifications at the time of publication. Due 
to modifications to the system software, some functions, and specifications resulting from upgrades of 
application versions or other reasons, the illustrations and screenshots used in the explanation may 
differ from actual specifications. For the latest information, refer to the Yamaha Pro Audio website. 
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Preparation Work 

This section explains what you need to do before connecting the devices on-site. 

Installing software 

For this system example, ProVisionaire Design, ProVisionaire Control PLUS, and Dante Controller will be used. 

1. Download ProVisionaire Design and ProVisionaire Control PLUS from the download page on the Yamaha Pro
Audio website.

For the latest software version and system requirements, visit the following website: 
https://www.yamaha.com/2/provisionaire/ 

2. Unzip the downloaded compressed file.

3. Double-click the .exe file and follow the installer instructions to install the software.

4. Download Dante Controller from the Audinate website and install it.

For more information on Dante, visit the Audinate website. 
https://www.audinate.com/ 

Configuring devices with ProVisionaire Design 

Use ProVisionaire Design to create configuration files in advance to be imported into devices such as a processor, 
controller, and power amplifier. 

Launching ProVisionaire Design 

Launch ProVisionaire Design. For more information on how to use ProVisionaire Design, refer to the “ProVisionaire 
Design User Guide.” For details on components, refer to the “ProVisionaire Design Component Guide.” 

1. Launch ProVisionaire Control PLUS from your computer’s Start menu.

2. If the “Network Setup” dialog appears, click [OK] or [Cancel].
Network settings will be performed during the on-site work.

3. The “Startup” dialog appears. Click [New].

https://www.yamaha.com/2/provisionaire/
https://manual.yamaha.com/pa/pv/pvd/
https://manual.yamaha.com/pa/pv/pvd/
https://manual.yamaha.com/pa/pv/pvd_cg/
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Placing devices on the Project sheet 

Place the devices included in this example configuration on the Project sheet. 

1. Drag and drop the devices to be controlled via ProVisionaire Design from the Devices area on the left side of
the screen onto the Project sheet.
In the Settings dialog, select the device information, and then click [OK]. You can change this information
later. If undecided, click [OK] without making any changes. In this example, the following devices will be placed.

・DME3 Processor ×1
・MCP2 Wall-Mount Controllers ×2
・XMS12s4-D Power Amplifier ×1

The XMS series power amplifiers will be supported in ProVisionaire Design v3.1. 

2. Name the two MCP2 units so that you can identify them easier.
To name them, double-click the text or enter the name in the Device Name field of the Properties area. In this
example, we will name them MCP2(ZONE1) and MCP2(ZONE2).
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Configuring the processor 

Create a processor (DME3) configuration and set up the DME to control peripheral devices. 

Placing and connecting components 

The DME is a freely-configurable processor that enables you to make flexible settings for its internal circuit 
processing. To make the DME appropriate for your system, follow the steps below to create a configuration. 

1. Double-click DME3 on the Project sheet.
The DME3 design sheet opens. This is where you will place components.

2. Drag and drop components from the Components area on the left side of the screen onto the design sheet.

In this example, the following components will be placed. 
* Select the number and type of components to be placed that is appropriate for your system.

• Analog In ×1
• USB In ×1
• Fader (Stereo 3Ch) ×1
• Fader (Mono 4Ch) ×1
• Matrix Mixer (6In 3Out) ×1
• Source Selector (4Source 1Ch) ×2
• PEQ (Mono 4Band) ×4
• Standard SPP (1way) ×4
• Dante Out ×1
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3. Enter port labels for In and Out type components and Matrix Mixer components.
There are two ways to enter port labels:

- Select the component, right-click to select [Edit Port Label], and then enter the label.

- Double-click the component to open the component editor, and then enter the label in the gray text box.

In this example, the labels are entered as shown below. The names you enter should match your system. 

4. From the [Tools] menu, select [Duplicate Port Label].
If this option is selected, the port labels will be automatically duplicated when you connect components in the
next step.
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5. Connect components in accordance with the signal flow.
Drag an output port to an input port of the destination component to draw a line to connect the components.

 Tips 

You can also connect multiple lines simultaneously by selecting multiple output ports. In addition, the following 
features are available: the Unbundle Wires function (which displays individual lines so that they will not overlap 
each other after connection) and the Trace Signal Path function (which displays the signal path). For useful 
functions related to component placement and connections, refer to the “Design Sheet” section in the 
“ProVisionaire Design User Guide.” 

Setting up the components 

Set up each component in accordance with your system. In this example, we will set up the matrix for the Matrix 
Mixer component. 

1. Double-click the Matrix Mixer component.
The component editor opens.

2. To mix L and R into mono, set the matrix as shown in the screen image below.
Select a square, right-click it, and then click [On] to turn it on.

https://manual.yamaha.com/pa/pv/pvd/ja/13_DeviceSheet_DME7_ja.html#13_7_design_sheet
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Analyzing the configuration for any problems (Compile) 

Analyze the placement and connections of the DME components for any problems. 

1. Click     , which is one of the tool buttons at the top of the design sheet. 

2. Review the analysis results.
If the message “Completed successfully” appears, there are no problems. If there are any problems, click the

to view possible solutions, and take appropriate action. 
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Storing the settings to be assigned to the controller (Snapshot) 

You can store the current component status as a snapshot. Storing a snapshot enables you to quickly recall the 
saved component settings. 

In this example, we will store the status of each sound source selection in the Source Selector component as a 
snapshot. By placing a recall button for this snapshot on the control panel, you will be able to switch among sound 
sources from the control panel. 

1. On the DME3 device sheet, select the “Parameter Sets” tab in the left column.
This area is used to configure the snapshot.

2. Click [New]. Enter a desired name in the dialog that appears.
A box (parameter set) is created to encase the parameters to be recalled via the snapshot.
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3. While holding down the <Ctrl> key, drag and drop the Source Selector component into the Parameter Sets
column.

4. Double-click the Source Selector component to open it.

5. With the “1 (BGM1)” button selected in the Source Selector component editor, click the [Store] button in
the Snapshot column. Enter a desired name in the dialog that appears, and then click [OK].
A snapshot is stored with the ZONE1 sound source set to BGM1.



Workflow 

Setup Guide (Workflow） 16 

6. Select the “2 (BGM3)” button in the Source Selector component editor, click the second line (002) in the
Snapshot column, and then click the [Store] button in the Snapshot column. Enter a desired name in the
dialog that appears, and then click [OK].
A snapshot is stored with the ZONE1 sound source set to BGM2.
Store the “3 (PC)” snapshot in the same way.

Once you have stored three ZONE1 (Source Selector) snapshots, store ZONE2 (Source Selector(2)) snapshots in the 
same way. 

7. As in step 2, click [New] to create a new parameter set.

8. As in step 3, while holding down the <Ctrl> key, drag and drop the Source Selector(2) component into the
Parameter Sets column.

9. As in steps 4 through 6, store three parameter sets with the BGM1, BGM2, and PC sound sources selected
respectively in the Source Selector(2) component editor.

Once you have stored them, select each snapshot, and then click [Recall] to make sure that the Source Selector
buttons switch as intended.

This completes the storing of snapshots that are used to switch the sound sources. You will use these settings later 
in the “Creating a control panel with ProVisionaire Control PLUS” section. 
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Grouping multiple faders or buttons for simultaneous control (Parameter Link Group) 

Create a Parameter Link Group to control multiple volume level faders or buttons simultaneously.  
By assigning a parameter link group to the control panel or wall-mount controller, you can adjust the audio volume of 
multiple speakers or mute them simultaneously. 

In this example, we will group components to meet the following requirements. 

Requirements Components to group 

Adjusting the audio volume of all ZONE1 speakers
simultaneously Faders for Ch1 and Ch2 of the Fader(2) component 

Adjusting the audio volume of all ZONE2 speakers
simultaneously Faders for Ch3 and Ch4 of the Fader(2) component 

Adjusting the audio volume of all speakers
simultaneously Faders for Ch1 through Ch4 of the Fader(2) component 

Turning all speakers on or off simultaneously ON buttons for Ch1 through Ch4 of the Fader(2) 
component 

1. Double-click the Fader(2) component.

2. Select the “Parameter Link Group” tab on the left side of the screen.
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3. Click [New].
Enter a desired name in the dialog that appears.

4. While holding down the <Ctrl> key, drag and drop the Ch1 and Ch2 faders into the Parameter Link Group
area.

With the group selected, click [Open] to open the combined single fader. 
Move the fader to confirm that appropriate components are linked. 

5. Configure other parameter link groups in the same way as in steps 3 and 4.
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Configuring the function so that the DME will control peripheral devices (Conductor) 

The Conductor function enables the DME to control peripheral devices. You can register snapshots and parameters 
of the DME and peripheral devices to a Conductor component, and assign them to an external controller to control 
the peripheral devices. 

Conductor’s basic flow 

1. Register items (that you wish to control) to the list in the Conductor component editor.

2. Specify the registered list number in the controller's component editor.

This example describes basic operation. However, there are multiple ways to configure and use the 
Conductor function. As an advanced example, you can place a Conductor component on the Control layer 
and use it in combination with logic components. This example also explains how to control the DME 
itself by assigning its own components and snapshots. However, you can also use the same method to 
assign components of peripheral devices, such as a power amplifier, and control them.  
For details, refer to the “Conductor” section in the “ProVisionaire Design Component Guide.” 

In this example, we will configure the Conductor, assuming that you will be using the MCP2 wall-mount controller to 
control the following parameters: 

MCP2 in ZONE 1 MCP2 in ZONE 2 

Turn a knob: Adjusts the volume of all speakers in ZONE 1. 

Press a knob: Turns all speakers in ZONE 1 ON or OFF. 

Turn a knob: Adjusts the volume of all speakers in ZONE 2. 

Press a knob: Turns all speakers in ZONE 2 ON or OFF. 

https://manual.yamaha.com/pa/pv/pvd_cg/
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1. Click the [Conductor] button on the toolbar.

2. In the “Open Conductor Component Editor” dialog, select the DME you want to use as the command source,
and then click [OK].

The Conductor component editor opens. This is where you will register items to control. 
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First, register the ON/OFF buttons. 

3. Double-click the Fader(2) component on the DME3 design sheet.
The component editor opens.

4. Make sure that the [Fixed Value] tab is selected in the Conductor component editor.
If the [Variable Value] tab is selected, switch to the [Fixed Value] tab.

 Tips “Variable Value” and “Fixed Value” 

The Conductor component editor features two tabs: “Variable Value” and “Fixed Value.” 
Select the tab that is appropriate for the items you are registering. 

・Variable Value
Select this tab for continuously-variable parameters. The values are controlled via the controller's encoders or
faders.
Examples: Adjusting fader levels, rotating knobs, etc.

・Fixed Value
Select this tab for fixed-value parameters and presets. Press a button on the controller to trigger operation or
toggle between settings.
Examples: ON button, MUTE button, recalling a fader's fixed value, recalling a preset, etc.

5. While holding down the <Ctrl> button, drag and drop the ON button from the Fader component editor to the
list in the Conductor component editor.
Drag and drop Ch1 and Ch2 buttons to No. 1, and Ch3 and Ch4 buttons to No. 2.
To delete a row from the list, select the row and press the [Clear] button.

6. Enter a desired label in the Label column.
Click the cell you want to edit to open a box in which you can enter the label.
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7. Specify the type of trigger (1Shot or On/Off) in the Trigger Type column.
Click the cell you want to edit to open a box in which you can enter the type.

 Tips Trigger Type “1Shot” and “On/Off” 

For “Fixed Value,” you can choose from the following two trigger types. Select the appropriate option based on 
the type you want to execute. 

• 1Shot
Transmits the same value each time it is triggered.

• On/Off
Toggles between On and Off each time it is triggered. You cannot assign any parameters other than On/Off
(such as fixed level values).

When you are finished setting up, click [Apply]. Next, register the volume control faders. 

8. Select the [Variable Value] tab in the Conductor component editor.

9. Select the “Parameter Link Group” tab on the left side of the DME design sheet, and then open the “ZONE1
Volume” and “ZONE2 Volume” parameter link groups created in the “Grouping multiple faders or buttons for
simultaneous control (Parameter Link Group).”

With the desired group selected, click [Open] to open the fader windows. 
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10. While holding down the <Ctrl> key, drag and drop the faders to the Conductor component editor.

11. Enter a desired label in the Label column.
Click the cell you want to edit to open a box in which you can enter the label.
When you are finished setting up, click [OK] to close the Conductor component.

This completes the Conductor registration. 
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Assigning functions to the controller 

Assign the items registered in Conductor to the controller (MCP2). For more information on the MCP2 settings, 
refer to the “MCP2” section in the “ProVisionaire Design User Guide.” In this example, we will assign items so that 
the resultant screen will look like the one shown in the “Configuring the function so that the DME will control 
peripheral devices (Conductor)” section. 

1. Double-click the MCP2(ZONE1) icon on the Project sheet.
The MCP2 component editor opens.

2. Select [Single Function] in the [Mode] list box.

3. In the Function column, select [Knob & Switch], and then [Conductor Component].

https://manual.yamaha.com/pa/pv/pvd/
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4. Specify the items you want to assign.

① Enter the page title you want to display on the MCP2 screen.

② Select the DME you configured in the “Configuring the function so that the DME will 
control peripheral devices (Conductor)” section. 

③ 
The Conductor list you configured in the “Configuring the function so that the DME will 
control peripheral devices (Conductor)” section appears here.  
Select the operation to be triggered by rotating the button. 

④ 
The Conductor list you configured in the “Configuring the function so that the DME will 
control peripheral devices (Conductor)” section appears here.  
Select the operation to be triggered by pressing the button. 

When you have finished setting up, click [OK] to close the screen. 

5. Repeat steps 1 through 4 for MCP2 (Unit ID02) in ZONE2.

This completes the settings for MCP2. 
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Configuring the power amplifier 

Set the impedance and audio in/out settings in ProVisionaire Design in accordance with your system. 

The XMS series will be supported in ProVisionaire Design V3.1. 

Information about the XMS series will be updated from time to time. 

1. Set the power amplifier impedance.
In this example, we will set high impedance for all output channels.

2. Configure other components as needed (speaker presets, matrix, etc.).

3. When you have finished setting up, click [Save] under the File menu to save the file.

This completes the preparation work using ProVisionaire Design. Next, we will configure settings in ProVisionaire 
Control PLUS. However, we will leave ProVisionaire Design running. 
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Creating a control panel with ProVisionaire Control PLUS 

Create a control panel in ProVisionaire Control PLUS so that you will be able to select audio sources, turn on/off or 
adjust the volume of all speakers in the lobby using the touch panel in the backroom. Since you will be using both 
ProVisionaire Control PLUS and ProVisionaire Design simultaneously, we recommend that you have two or more 
display monitors ready. 

Launch ProVisionaire Control PLUS 

Use ProVisionaire Control PLUS to create a control panel. For more information on how to use ProVisionaire Control 
PLUS, refer to the “ProVisionaire Control PLUS User Guide.” 

1. Launch ProVisionaire Control PLUS from your computer’s Start menu.

2. Click “New Project” to create a new file. 

3. If the “Setup” dialog appears, click “OK” or “Cancel.”
Network settings will be performed during the on-site work.

4. Follow the wizard that appears to enter desired information.
Select DME3 for [Add Device]. For [Unit ID], specify the same Unit ID as the DME3 that was placed using
ProVisionaire Design. Once the wizard is complete, the work area opens.

https://manual.yamaha.com/pa/pv/pvcp/


Workflow 

Setup Guide (Workflow） 28 

Placing the controllers on the control panel 

Drag and drop buttons and faders (to be operated on the controller panel) from the ProVisionaire Design component 
editor to the work area in ProVisionaire Control PLUS. 

1. Locate the DME3 design sheet in ProVisionaire Design.

2. Open the component editor for the target component.

ProVisionaire Design 

3. While holding down the <Ctrl> key, drag and drop the target widget into the work area of ProVisionaire
Control PLUS.
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In this example, we will place the following components. 

Component Target for drag and drop Requirements 

Fader (2) Fader (Ch1) Adjusting the volume of the front speakers in ZONE 1 

Fader (Ch2) Adjusting the volume of the ceiling speakers in ZONE 1 

Fader (Ch3) Adjusting the volume of the front speakers in ZONE 2 

Fader (Ch4) Adjusting the volume of the ceiling speakers in ZONE 2 

[ON] button (Ch1) Turning the front speakers in ZONE 1 ON and OFF 

[ON] button (Ch2) Turning the ceiling speakers in ZONE 1 ON and OFF 

[ON] button (Ch3) Turning the front speakers in ZONE 2 ON and OFF 

[ON] button (Ch4) Turning the ceiling speakers in ZONE 2 ON and OFF 

Component Target for drag and drop Requirements 

Parameter Link Group 
- Total Volume

Fader Adjusting the volume of all speakers 

Parameter Link Group 
- Total ON/OFF

[ON] button Turning all speakers ON and OFF 
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Component Target for drag and drop Requirements 

Snapshot 
- Source Selector

Zone1-BGM1 Switching the ZONE 1 sound source to “BGM1” 

Zone1-BGM2 Switching the ZONE 1 sound source to “BGM2” 

Zone1-PC Switching the ZONE 1 sound source to “PC” 

Component Target for drag and drop Requirements 

Snapshot 
- Source Selector (2)

Zone2-BGM1 Switching the ZONE 2 sound source to “BGM1” 

Zone2-BGM2 Switching the ZONE 2 sound source to “BGM2” 

Zone2-PC Switching the ZONE 2 sound source to “PC” 



Workflow 

Setup Guide (Workflow） 31 

4. Add labels to make each fader easier to identify.
While a fader is selected, go to the [Text] field under the [Label] column in the “Properties” area to enter the
label to display it.

 Tips 

If the “Properties” area is not displayed on the screen, click the [View] menu, and then select [Properties] to 
display it. 

If you have forgotten the type or channel of the placed component, refer to the [Control] column in the 
“Properties” area. 
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Designing the control panel 

You can add shapes and text to your liking, and arrange the positioning as desired. 

①Adding a shape  Select your desired shape from the “Widgets” column, and then drag and drop it into the 
work area. 

  Tips To add text, place a [Rectangle], [Ellipse], [Polygon], etc., select “Properties” area 
> [Text], and then enter text inside the shape.

②Modifying appearance
(color and text)

 While the target widget is selected, you can modify the appearance, such as color and 
text, in the “Properties” area. 

③ Arranging the position of 
your widgets

 You can use the buttons at the top of the work area to stack or arrange the position of 
your widgets. 

Once you have completed your design, save your file and exit the software. 

This completes the preparation work. 
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On-site Work 
This section explains the steps to be performed when the devices are actually present, such as on-site. 

Connecting the devices 
After mounting the various devices in a rack, connect them as follows. 

This example uses a system that features an independent control network and a Dante network. If the 
control network and the Dante network are separate, as in this example, you need two PC network 
interfaces.  
While Dante audio routing will use a redundant connection, it is assumed that the system will use only a 
primary connection.  
When delivering and installing the system, determine the specifications for network operation in 
accordance with your requirements. Note that some models may not support Dante redundancy, or 
operations in which the control network and the Dante network are separate. For more information, 
refer to the “New CIS Ecosystem Setup Guide (Network).” 

Construction and installation should be carried out by a specialized construction company. 
For construction and installation precautions, refer to the manual for each product. 
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Powering on the devices 

Turn on the power to the input devices in the system, then finally to the power amplifier. We recommend that you 
use a power distributor or similar device to supply and distribute power to the system. 

Building the network 

Configure the network settings on the setup computer so that all networked devices can communicate with one 
another. 

In this example, we will use automatic IP address assignment for both the control network and the Dante 
network. Some models may not support automatic IP address assignment. For more information on IP 
addresses, refer to the “New CIS Ecosystem Setup Guide (Network).” 

1. Launch ProVisionaire Design on the setup computer.
The “Network Setup” dialog appears.

2. Click the [Open Network Connection] button.
The “Network Connections” window appears.

3. Select the adapter to be connected to the control network, and then click [Properties].
The “Local Area Connection Properties” dialog appears.

4. Select [Internet Protocol Version 4 (TCP/IPv4)], and then click [Properties].
The “Internet Protocol Version 4 (TCP/IPv4) Properties” dialog appears.

5. Select the [Obtain an IP address automatically] box, and then click [OK].

6. Return to ProVisionaire Design, select the check box for the network card that will communicate with the
devices, and then click [OK].
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Finding devices with ProVisionaire Design 

Set up ProVisionaire Design to communicate with the devices. 

1. When the file selection dialog appears, click X to close it.
You can select a file after the devices are found.

2. Make sure that all devices are displayed in the network area.
If the Network area is not displayed, select the [Network] tab on the left side of the screen.

If devices are not displayed in the Network area, check the device connections and make sure that the 
network card connected to the devices is correct in the “Network Setup” dialog. If the network card is 
selected correctly but the devices are not displayed, restart the devices or ProVisionaire Design. 

In this device configuration, all devices (DME3, MCP2, XMS series) that communicate with ProVisionaire 
Design are equipped with DHCP functionality that supports Link Local by factory default. Therefore, 
there is no need to manually set the IP addresses on the devices. Simply match the PC network settings, 
and all devices will be recognized by ProVisionaire Design. The method for building device and computer 
networks varies depending on the system's device configuration. For the IP address assignment of each 
product, refer to the manual for each product or the “New CIS Ecosystem Setup Guide (Network).” 
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Specifying Unit IDs 

To identify devices, specify their Unit IDs. Since products with the same model number have the same Unit ID by 
default, you need to change them to unique numbers. 

1. Click [Unit ID] in the Network area.
The “Change Unit ID” dialog opens.

By default, the Unit IDs for both MCP2s are set to “01.” Change them to unique numbers to avoid duplicates. 

2. Click the identify button (framed in red in the screen image below) in the “Change Unit ID” dialog, and while
making sure that the corresponding unit is flashing, specify the Unit ID for the MCP2 placed in ZONE1 to
“01” and the Unit ID for the MCP2 placed in ZONE2 to “02.”

3. When you are finished, click [OK].
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Pushing ProVisionaire Design settings to devices 

Push the DME configuration data and MCP2 settings you created during the preparation work into the devices. 

If the device firmware is not up to date, update it before pushing the settings into the devices. For 
instructions on updating the firmware, refer to the “Firmware update” section. 

1. From the [File] menu, select [Open], and open the project file you created during the preparation work.

2. Make sure that the device indicator on the Project sheet lights up green.

If the indicator does not light up, make sure that the Unit ID for the corresponding hardware device 
matches the Unit ID for the device on the Project sheet. For instructions on checking and changing the 
Unit ID for the hardware device, refer to the “Setting the Unit ID” section. To change the Unit ID for a 
device on the Project sheet, click the device on the Project sheet, and then from the Properties area, 
select Device > Unit ID. 
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3. Click [Online] on the toolbar.
The “Synchronization” dialog appears.

4. Select [To Device], and then click [Online].
The ProVisionaire Design settings are transfered to each device.
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Configuring Dante Settings using Dante Controller 

Configure Dante audio signal settings using Dante Controller. For more information on Dante, refer to the Audinate 
website. 

1. Launch Dante Controller from your computer's Start menu.

Dante Controller can be installed from the Audinate website. 
https://www.audinate.com/ 

2. Make sure that the device appears in the Network View screen.

3. Configure routings.
In this example, route signals as follows. When setting up the actual system, configure routings in accordance
with the input and output channels of the system.
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4. Configure various settings in accordance with the system.
In this example, configure the settings as follows. When setting up the actual system, configure the settings in
accordance with that system.
When you are finished, click the Restart button.

 Selecting Dante interface
From the “File” menu, select “Interface” to open the settings screen. Select interface to use for Dante. In this
example, we will use only the primary interface. Specify the settings as shown below. If you plan to use a
secondary network, configure the interface for the secondary network.

If you plan to use a system that features the Dante and control networks on separate networks, as in 
this example, you will need two PC interfaces. Select separate interfaces for the Dante network and the 
control network. 

 Device settings
Double-click each device on the Routing screen, and then select the “Device Settings” tab to configure the
device settings. Specify the same sampling rate for all Dante devices.

 Tips 

When a DME device is brought online, it automatically writes the sampling rate specified in the “Properties” area 
of ProVisionaire Design to the device's Dante module. If you change the sampling rate, make sure that the device’s 
sampling rate matches the Dante’s sampling rate. Since the XMS series devices are equipped with a sampling rate 
converter (SRC) between the device and Dante, make sure that the same sampling rate for Dante is specified 
across all Dante devices. 
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 Network settings
Double-click each device on the Routing screen, and then select the “Network Settings” tab to configure the
network settings.
Configure the switch settings and IP addresses.

① Switch settings
Select “Redundant-Control separated,” since we will make a redundant connection, and use the control network
and Dante network separately. Select “Daisy-chain” if you plan to use a daisy-chain connection, or “Control
merged” if you plan to merge control and Dante signals on a single LAN cable. Choose an option that suits your
system.

② Address
In this example, check “Obtain an IP address automatically.” You will not usually need to manually set the Dante
IP address. Unless there is a special reason, check “Obtain an IP address automatically.”



Workflow 

Setup Guide (Workflow） 42 

Verifying that the system is functioning properly 

Verify that the system functions as required. 

1. Input an audio signal to the DME3 from a media player, computer, etc.
Open the “Analog In” component editor and “USB In” component editor on the DME3 design sheet in
ProVisionaire Design, and make sure that the input meters are moving. Adjust the gain and volume level in the
“Analog In” component editor, “USB In” component editor, and “Fader” component editor.

2. Make sure that sound is output from the speakers.
Open the volume-related component editor on the power amplifier device sheet in ProVisionaire Design.
Unmute audio, and gradually raise the fader to make sure that the sound is being output from the speakers.

Notice 
To avoid unexpectedly loud sounds, raise the fader gradually from its fully turned down position. 

3. Make sure that you can operate the system properly from the MCP2.
Operate the knobs on the MCP2 to make sure that speaker on/off and volume adjustment are functioning
properly.
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Storing initial data (Snapshot) 

After adjusting acoustics and setting the parameters for the amplifier and processor on-site, store a snapshot of the 
settings as the initial data. To store a snapshot, first create a group of components to save in a parameter set, and 
then save the state of those components as a snapshot. 

1. Input a test signal on-site, and adjust acoustics.
Adjust acoustics by specifying appropriate values in the DME3's “Speaker Processor” component editor and
“PEQ” component editor.

2. On the DME3 device sheet, select the “Parameter Sets” tab in the left column.
Use this tab area to store parameter sets and snapshots.

3. Click [New]. Enter a desired name in the dialog that appears.
A parameter set is created.
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4. Click [Add Device].
The settings for all components placed on the design sheet are registered.

5. Click [Store] in the “Snapshot” column, and then enter a desired name.
The current settings are stored as the initial data.

6. While the snapshot stored in step 2 is selected, click the [Power On Default] button in the “Recall” column.
This snapshot will be recalled when the DME3 starts up.

Once all settings are complete, save your project. 

This completes the operations in ProVisionaire Design. 
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Exporting the controller file to the DME (Custom Control Panel) 

Export the controller file created in ProVisionaire Control PLUS during the preparation work to the DME3. You can 
then operate the control panel by accessing the controller file stored in the DME3 from a control terminal. 

Start ProVisionaire Control PLUS, and open its controller file created during the preparation work. 
When the “Setup” dialog appears, select the same network interface as for the DME3.  
If you have closed the “Setup” dialog, you can open it by selecting [Setup] menu > [Network]. 

1. Make sure that the controller file to be transferred is selected in the “Controllers” area.

2. From the [Controller] menu, click [Export].
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3. Select the [to DME] tab, select the DME3 to export to, and then click [Transfer].

The export is now complete. Close ProVisionaire Control PLUS. 
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Verifying that peripheral devices can be controlled from the control terminal 

Verify that from the control terminal you can access the controller file stored in the DME3, and control peripheral 
devices. 

If the control terminal is a TCD10 

Simply connect the TCD10 to the same network as the DME3 to display the control panel on the screen 
automatically.  
Operate the control panel to verify that you can control the peripheral devices properly. 

If the control terminal is not a TCD10 

Follow the steps below to access the controller file. 

1. Specify the network for the control terminal to be the same network as the DME3.

2. Open the browser on the control terminal and enter the DME3's IP address in the address bar.

3. Operate the faders and buttons on the displayed control panel to verify that you can control the peripheral
devices properly.

 NOTE 

  You can view the IP address for the DME in the “Control Port / Custom Control Panel” screen on the display of the 
DME unit. 

This completes the setup required for on-site work. 
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Maintenance Work 
This section explains the tasks performed via ProVisionaire Design during maintenance and inspection after on-site 
work is complete. 

• Data backup

• Firmware update

• Initialization

Data backup 

Save the device settings at the start of the work to your PC as a backup. 

1. Launch ProVisionaire Design.

2. Select your PC's network card, and then click [New] on the file selection screen.

3. From the [File] menu, click [Go Online–From Devices].
The “Synchronization” dialog appears.

4. Select the devices from which you want to extract data, and then click [Online].
The device settings are applied to the Project file.

5. From the [File] menu, click [Save], and enter a desired name and location in the dialog that appears to save
the Project file.
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Firmware update 

Update the device firmware to the latest version. 

1. Download the latest ProVisionaire Design firmware from the Yamaha Pro Audio website.

Yamaha Pro Audio website https://www.yamaha.com/2/provisionaire/ 

2. Unzip the downloaded compressed file and install it.

3. Launch ProVisionaire Design.
After launching the software, select your network card and make sure that the device names appear in the
network area.

4. From the [System] menu, click [Device Information].
The “Device Information” dialog opens.

5. Click [Update Firmware].
The “Update Firmware” dialog opens.

6. Select the device for which you want to update firmware, and then click [Update].
The firmware is updated.

For more information on how to update Dante firmware, refer to the “Dante Firmware Update Guide.” 
Note that for the DME series, RM-WAP, RM-CG, RM-TT, and VXC2P, the Dante firmware will be updated 
at the same time as the firmware for the corresponding device is updated. 

For some models (such as the DZR/DXS-XLF series and Rio-D3 series), firmware cannot be updated via 
ProVisionaire Design. Use the dedicated updater to update such firmware. For more information, refer to 
the manual for the corresponding products. 

https://www.yamaha.com/2/provisionaire/
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Initialization 

You can initialize the device settings. 

1. Launch ProVisionaire Design.
Select the network card and a desired project file, and then make sure the names of devices on the network
appear on the screen.

2. From the [System] menu, click [Device Information].
The “Device Information” dialog opens.

3. Click [Initialize...].
The “Initialize” dialog opens.

4. Select the items you want to initialize, and then click [Initialize].
The device settings are initialized.

For some models, the device settings cannot be initialized via ProVisionaire Design. For more 
information, refer to the manual for the corresponding products. 
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